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PREFACE

Computers play a vital role in the modern world, and even the most basic jobs today involve technology. Therefore, 

computer education becomes essential in any student’s development. Expertise in computing enables children 

think critically, be more creative and innovative, giving space for collaborative work and individual effort.

The series of books (Class III – IX) aim to holistically develop digital skills, keeping pace with the dynamically 

changing industry requirements. 

IT education has no boundaries and irrespective of the field of work, each one is expected to have the following 

digital skills:

 MS Office (MS Word, MS Excel, MS PowerPoint)

 Photo / Image Editing

 Programming

 Website development

The enriched curriculum therefore covers a wide variety of topics across various classes: TUXPAINT; MS Word 

2007 (Level I, II & III) ; MS Excel 2007 (Level I, II & III); MS PowerPoint 2007 (Level I & II); Image / Photo editing 

software using GIMP 2.8; Scratch Programming; HTML Programming; Web creation tool using WordPress. 

The curriculum uses only open source software (freely available on the Internet) installed in Windows 7 Operating 

system.

A brief description of every concept and its application / purpose is provided in every lesson with colorful screen 

shots. This not only attracts the readers but also gives them an experience of self-learning. ‘Activity Based Learning’ 

exercises have been included as part of the curriculum. 

We hope this text book finds its place in the readers’ library for future references.
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INTRoduCTIoN To MS PowERPoINT &  
NAvIgATIoN oF THE PowERPoINT wINdowCh
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INTRoduCTIoN

Welcome to Microsoft PowerPoint!!!

PowerPoint (PPT) is a powerful, easy-to-use presentation software program which allows to create a professional-

looking electronic slide shows. PPT is used to present information in an organized manner to an individual or 

group.

PowerPoint was created by Robert gaskins and dennis Austin at a software company named Forethought. It was 

released on April 20, 1987, initially for Macintosh computers only. Microsoft company acquired PowerPoint and 

set up a new business unit for PowerPoint.

Microsoft PowerPoint offers users many ways to display information from simple presentations to complex 

multimedia presentations.

A PowerPoint presentation is a collection of slides. A slide is a frame or a page in a presentation that represents data. 

Presentations can contain text to display information or multimedia effects to make it impressive and interactive.  

PowerPoint presentations are commonly used in business meetings and for training and educational purposes. 

Presentation files are saved with .pptx extension.

The salient features of PowerPoint are:
•	 Quick,	easy	and	high	impact	of	visuals.

•	 Availability	of	templates.

•	 Can	apply	animations	and	sound	effects.

•	 Can	embed	existing	text	and	graphics	from	other	Microsoft	Office	applications.

•	 Presentations	can	be	linked	for	online	users.

•	 Projector	Wizard	automatically	sets	the	correct	screen	resolution	for	the	projector	system.

The first version of Powerpoint  
was named “PRESENTER”.  

It was invented by Robert Gaskins, 
later sold to Microsoft for $14 Million

9
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How to load MS PowerPoint window? 
Step 1 : Go to Start button

Step 2 :  Click on Microsoft Office 

Step 3 :  Click on Microsoft PowerPoint 

Step 4 :  Create a blank presentation

Now let us learn the components of the PowerPoint window.

 1.Office 
button 

 2.Quick 
Access tool 
bar 

 
3.Title bar  4.Menu bar 

 
6.Outline 
tab 

 

5.Slides tab 

 
9.Slide pane  

7. Title 
placeholder 

 
11. Status bar 

 

12. Zoom 
control 

 
8.  Subtitle 
placeholder 

 10. Notes 
Pane 
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write down the components and the inference you made while navigating through the Pow-
erPoint window.

More than 500 

Million people 

use PowerPoint 

worldwide.
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LAB ACTIvITY

Open  the presentation Solar_System.pptx

a. Click on the cursor to the different locations (from 1 to 5) in the document as shown below.

 2. scroll up this button 
repeatedly till you 
reach the first slide. 

 1. scroll down this button 
repeatedly to see all the 
sides, one after the other, 
till you reach the last slide.  

 3. Click on any slide 
to see that slide. 

b. Close the PowerPoint window (FileExit).



13

 BRAIN dEvELoPER 

FILL IN THE BLANKS

1.  A PowerPoint presentation is a __________ of slides.

2.  Presentation files are saved with __________ extension.

3.  With PowerPoint, we can have simple presentations and complex _____________    presentations also.

4.  PowerPoint was created by ____________ and ______________.

5.  A _________ is a frame or a page in a presentation that represents data.  

6.  The three features of PowerPoint representation is ____________________, _________________________

_______, _____________.

7.  A Slide is a ___________________.

Teacher’s Signature
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Now, in this Chapter we will see how to create a new presentation and to save it.  Also we would introduce you to 

slides and different types of layouts available in MS PowerPoint.

Open PowerPoint from the Start menu on your desktop.  You will have a new blank presentation with one slide 

which appears by default. 

PowerPoint offers three ways to create a presentation: Blank presentation, from design Template, or from  

Auto Content wizard.

The Blank presentation option is one of the more commonly used methods. It offers several blank slides, with 

layouts for text and graphics.

To CREATE A BLANK PRESENTATIoN
•	 Open	PowerPoint.

•	 A	slide	featuring	a	place	for	a	title	and	subtitle	appears	by	default.	You	can	start	your	presentation	with	this	
slide or choose a different slide layout.

We can also create a new presentation while PowerPoint is already open.  

 Create a new blank presentation by using the following commands.

(File New Blank presentation Create). 
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Step 1:  Click in the title placeholder and type “Caring for Pet Animals”. 

Step 2:  In the subtitle placeholder type “Life span, special needs etc.”  

Step 3:   Save the presentation with the name Pet-Animals.pptx (File  Save). 

Step 4:   Close the presentation (File Close). 

SLIdE LAYouT

Layout is the method of placing things or objects on a slide in a specific order.  A layout consists of placeholders or 

boxes with dotted borders which hold titles, body text, bulleted lists, etc.

TYPES oF SLIdE LAYouT
  Title slide

 Section header

  Comparison

  Blank

  Title and content

  Two content

  Title only

  Content with caption

  Picture with caption

To insert text into a placeholder:

•	 Click	inside	the	placeholder.	The	placeholder	text	will	disappear,	and	the	insertion	point	will	appear.

•	 Type	your	text	once	the	insertion	point	is	visible.

•	 Click	outside	the	placeholder	when	you	have	entered	all	of	your	text	into	the	placeholder.

An average Powerpoint Slide 
has 40 words written on it. 

Instead of giving as complete 
sentences, the most important 

keywords are enough.
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When you enter text or use the icons to insert items, the placeholder text and/or icons disappear as soon as you 

start typing.

To insert a new slide

•	 Click	the	New	Slide	command	in	the	Slides	group	on	the	Home	tab.	A	menu	will	appear	with	your	slide	layout	

options.

•	 Click	the	slide	you	want	to	insert.	A	new	slide	with	the	chosen	layout	will	appear	in	the	center	of	the	Power-

Point window and in the pane on the left.

TRY THIS ouT IN THE LAB
Create a new presentation using the theme Concourse bacd.

Hint:  (File  New  installed themes  Concourse  Create)

The presentation should look like this.

Type the title and subtitle as shown here. You can replace it with your name and Class.
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Save the presentation with the name firstaid.pptx. (File  Save)

Close the presentation.  

Open the presentation firstaid.pptx. (File  Open  firstaid.pptx). 

In the title box add the words “For Beginners”.

1. Save the presentation in another name for example, firstaidbeginners.pptx.

 Hint:   (File  Save As)

2. Close the presentation.

Your slides should have sufficient  
“white space” or “negative space.”

D
iD

 Y
ou

 
Kn

ow
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 BRAIN dEvELoPER 

I) FILL IN THE BLANKS:

1.    ____________  is the method of placing things or objects on a slide in a specific order.  

2.   To insert a new slide, ___________ command in the Slides group on the _____________ tab should  

 be clicked.

3.   When we insert text into a placeholder, ___________ will disappear, and ____________ will appear.

4.  When you enter text or use the icons to insert items, the placeholder text and/or icons ___________  

 as soon as you start typing.

5.   A layout in  a presentation is ___________________.

6.    _________________ is  the change we notice when a text is typed in a placeholder.

7.   ________________, ____________________, ______________ and ________________  are some  

 of the slide layouts we have in PowerPoint.

Teacher’s Signature
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Adding images to your presentations makes them more interesting and engaging. Pictures, clip art, and screen-

shots can be inserted into PowerPoint to help you effectively communicate your ideas to the audience.

Adding clip art and pictures to your presentation can be a great way to illustrate and add decorative accents to the 

existing text. You can insert images from your computer, or add a screenshot of your own. Once an image has been 

inserted, you can resize, crop and move it to the location you want.

To insert an image from a file:

1. Select the Insert tab.

2. Click the Picture command in the Images group. The Insert Picture dialog box appears.

3. Select the desired image file, and then click open.
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4. The picture will appear in your slide.

You can also select the Insert Picture from File command in a placeholder to insert images.

To insert clip art:
1. Review the results from a clip art search in the Clip Art pane.

2. Select the desired image and drag the image into the placeholder.

3. The clip art will appear in your slide. 

 You can also select the Insert Clip Art from File command in a placeholder to insert clip art.

HANdS-oN ExERCISE
1. Create a new blank presentation of at least 3 slides with blank layout.

2. Insert a ClipArt picture of national bird in slide 2 and national flower in slide 3.

3. Resize and crop the pictures as shown below.



21

4. Change the layout of the slide 1 with “title only”.  

5. Type “wELCoME” in slide 1.  Change the slides 2 and 3 with content with caption.

6. Write any 2 sentences about the national bird and arrange the sentences in bullet format.

7.  Close and save the presentation as “National symbols.pptx”.

LAB ACTIvITY 
Create a blank presentation of 5 slides.

1. Change the layout of the first slide to “Title only” option.  Key in “Traffic Rules” in the subtitle placeholder.  

2. In the second and third slides, paste pictures of traffic signals and directions.

3. Change the layout of the fourth slide to “Comparison”.  Key in the do’s and don’ts while you are on the road 
in the given two columns to compare with.
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4.  Key in “Thank You” with your name, standard and section in the fifth slide.

5.  Close and save the presentation as “Traffic rules.pptx.”

TRY THIS ouT IN THE LAB

A. Type in the subtitle that you understand from the above slide.

B. What does this slide indicate?  Type in the rules we must follow when we come across this in the subtitle 
placeholder of the slide.

C. Change the layout of this slide to “two content.”  Type the rules indicated  by each colour in the second 
column.
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 BRAIN dEvELoPER 

I) FILL IN THE BLANKS

1.   ________________, ______________, and ___________ can be inserted into a presentation to communi-

cate effectively.

2.  You can select the ____________ from File command in a placeholder to insert images.

3. You can also select the Insert Clip Art from ________ command in a placeholder to insert clip art.

II) STATE wHETHER THE FoLLowINg STATEMENTS ARE TRuE oR 
FALSE

1.  We can crop or edit a picture or text after copying in a slide.

2.  The slide layout once selected cannot be changed at all.

3.   Adding clip art and pictures will add decorative accents to the presentation.  

4.  The title only layout contains two columns to compare with.

5.  The blank layout has placeholders to type title and subtitle in it.                                               

Teacher’s Signature

Use high- 
quality graphics 

including  
photographs.

DiD You  
Know
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Microsoft PowerPoint contains different views, which help us in getting a better understanding of the presentation.  

The five views in PowerPoint are:  Normal View, Slide view, Outline view, Slide sorter view and Slide Show view.

Normal view:  In Normal view, we can add text, pictures and create notes. Two options in Normal view are outline 

view and slides view.

outline view:  The outline view enables us to work with the text. With this view we can create summary slides.

Slides view:  Each slide can be viewed in detail one at a time. We can edit the pictures, text, etc. in this view.

Slide sorter view:  Slide sorter view allows us to see all the slides in the presentation at the same time, but would 

be displayed in miniature size. We cannot edit the text or pictures.

Slide show view:  We use slide show view to give a full screen presentation. This view would not allow us to edit 

the text or pictures.  

We can also have a full screen presentation by pressing the key F5.

uSINg THE KEY BoARd

The following are the shortcut keys to navigate through slides using the keyboard.

Page up: Takes you one slide back.

Page down:  Takes you one slide forward 

Ctrl+Home:  Takes you to the beginning of the presentation.

Ctrl+End:  Takes you to the end of the presentation.

Open solar system.pptx

Identify the view given above and view the presentation.

dIFFERENT vIEwS  
oF PowERPoINT Ch

ap
te

r

4
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View the solar system.pptx in outline view.  Add speaker notes.

View the solar system.pptx in various views of PowerPoint presentation.

View the slide sorter view and try to add speaker notes.  Does it allow to add?

View the presentation in Note pages view and add speaker notes.
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Press F5 and view the solar system in slide show presentation.

LAB ACTIvITY 

Create a blank presentation with five slides.

Enter the features and parts of a computer in the slides.
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In the 3rd slide insert a picture of a monitor and write two sentences about it. 

In the 4th slide insert a picture of CPU and write one or two sentences about it.

Save the presentation as computer.pptx.

View the presentation in slide show view and outline view and note down the differences in them.

 BRAIN dEvELoPER 

I) MATCH THE FoLLowINg

1. Page Up  Takes you to the end of the presentation                    

2. Page Down  Takes you to the beginning of the presentation 

3. Ctrl+Home   Takes you one slide forward

4. Ctrl+End Takes you one slide back

II) FILL IN THE BLANKS

1.   _____________, _____________, _____________, _____________, and _____________ are the  

 five views available in PowerPoint to view a presentation.

2.   _____________and _____________are the views that allow us to edit the text or pictures.

3.   _________________________ is the special feature of slide sorter view.

4.   ___________  is the shortcut key for presenting a PPT in full screen.

5.   ______________ is the view that helps us to create summary slides.

6.   Normal view has _________________ and _________________ options.

Teacher’s Signature

You can format all the 
slides in a presentation 
using the powerful slide 

master.
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APPLYINg TEMPLATES 
ANd dESIgNSCh

ap
te

r
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Templates are predefined designs and layouts with custom formatting where the user can include his/her own color 

schemes, slide styles and designs.

There are four categories of the templates:

 Blank Templates

 Design templates

 Content templates or presentations

 Web pages

PPT templates are easy to edit with high-quality slides, created by top designers around the world. Each free 

presentation is unique, which is why there are so many uniquely designed presentation templates to express each 

person’s creativity and style. All the installed templates are multi-purpose, which means that they can be used for 

any presentation project, whether it be for school projects, company report, lectures, exhibitions, etc.

You can use the templates to design your slides and presentations.

open the New Presentation dialog box.

Click the Office button and choose New. You can choose your template using any of the following methods.

use an installed template.

Click Installed Templates in the upper-left corner. Templates loaded on your computer when you installed 

PowerPoint appear in the dialog box. Double-click a template to create a presentation.
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Search online 

Make sure your computer is connected to the Internet, enter a search term in the Search box, and click the Start 

Searching button. Templates appear in the dialog box. Click a template to examine it. Double-click a template to 

download and use it to create a presentation.

use a template you created 

Double-click the My Templates button. The New Presentation dialog box appears. Select a template and click OK

To APPLY A SLIdE dESIgN To A SLIdE 
Step 1:  Select the slide to which you want to apply the design.

Step 2:  On the Design tab, right-click the design in the Themes group, and then click Apply.

When you are applying a slide design to a slide, all of the slides in your presentation are formatted with the selected 

slide design.  You are not given the choice of whether to apply the slide design to the entire presentation or only 

the currently selected slide.  

This occurs when you select the Slides view in the left-most pane (the slide navigation pane) in Normal view, or 

when the slide navigation pane has been closed.

To apply a slide design only to the currently selected slide, follow these steps:

1. In the Slide Design task pane, browse to the slide design that you want. (If the Slide Design task pane is not 
visible, click Slide Design on the Format menu.)

2. When you rest the mouse pointer over your selected design in the Slide Design task pane, a grey option button 
with an arrow appears. Click this button.

3. Click Apply to Selected Slides in the options button list.

Create	a	new	presentation	from	the	template	named	Quiz	show.	

(File New Installed templates Quiz show Create). 

At the start of the presentation, hit CTRL + 
H to make the cursor disappear. Hitting the 

“A” key will bring it back if you need it!

DiD You Know?
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Click the scroll down button to see the various slides with pre-designed quiz questions.  Close the presentation.

LAB ACTIvITY 
1. Create a presentation of 5 slides about a computer.

2. Create the second slide and include the picture of Charles Babbage.

3. Insert two more slides with pictures of computer and its components and type any two sentences about the 
input unit, output unit and processing unit.
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1. Insert the 5th slide with your name, class and section.  Change the design of the presentation to “trek”.

2. Change the design of the presentation to “paper” and see what happens.

3. Change the design to “oriel” to any one of the slide and save the presentation.

 BRAIN dEvELoPER 

FILL IN THE BLANKS:

1. ________ are predefined designs and layouts with custom formatting.

2. The slide design is on the __________ menu.

3. To apply the design, right click the design in the ________________ group and click apply.

4. ______________, ____________________, _________________ and ______________ are the  

 four types of templates.

5.   To apply a slide design to the current slide, from the ___________  pane, browse to the slide design that  

 you want.

Teacher’s Signature
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LEARNINg ANd APPLYINg BASIC  
ANIMATIoNS ANd TRANSITIoNS Ch

ap
te

r
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Slide transition is the animation that occurs when you advance from slide to slide within the presentation. You 

have many options for controlling the effects of the slide transition animation in PowerPoint. For example, you can 

often set the speed and direction of many transition animations. You can also add sound effects to complement the 

slide transition animation in PowerPoint, if desired.

You can add slide transition animation in PowerPoint to a single slide or to all slides at once. To do this, select the 

slide or slides to which you want to apply slide transition animation from the Slides pane. This pane appears at the 

left side of the Normal view. Then click the Transitions tab in the Ribbon. Then use the buttons and options in the 

“Transition to This Slide” button group to apply slide transition animation.

Click any of the available transition effects in the Transition to This Slide group. Then click the Preview button in 

the “Preview” button group to see the transition effect previewed in the slide window. After selecting a transition 

effect, set the properties of the transition using the “Effect Options” button within this button group.

You can change the transition effect speed. To do this, enter the amount of time to play the transition animation 

into the “Duration” spinner box. This spinner box appears in the “Timing” button group.

APPLYINg TRANSITIoN To oNE SLIdE:  
 Select the slide you want to modify.  By default, no transition is applied to each slide.  

 Select the Animations tab.  

 Locate the transition to the slide and apply to this slide.  

 Click drop-down arrow to display all available transition effects.

APPLYINg A SLIdE TRANSITIoN To ALL SLIdES IN A PRESENTATIoN:
 Select the slide you want to modify.  By default, no transition is applied to each slide.  

 Select the Animations tab.  

 Locate the transition to the slide and click apply to all.  

An animation effect is a special visual or sound effect added to a text or an object on a slide or chart. It is also 

possible to animate the text and the other objects using the buttons on the animation effects toolbar. Click on the 

effects tab and choose the animation you want to use.

Custom animation is a set of effects which can be applied to objects in PowerPoint (available by default) so that 

they will animate in the Slide Show.

PowerPoint provides four types of animations.  They are:

 Entrance animation:  An entrance animation determines the manner in which an object appears on a slide or 
move onto a slide.
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 Emphasis animation:  An emphasis animation does something to draw the attention of the audience towards 
the object.  For example, the object is enlarged.

 Exit animation:  An exit animation determines the manner in which an object leaves a slide.

 Motion paths animation:  This type of animation determines how an object moves around in a slide.

How will you apply animation to an object in a slide?

Step 1:  On your slide, select the text or image to be animated.

Step 2:  Animations--->Custom animation.  The custom animation pane appears.

Step 3:  Click Add Effect and choose from the drop-down menu.  

Step 4:  Click the effect you want to apply to your object.  Click OK .  Your newly added effect is reflected on the 
slide show.

Transition and animation effects provide visual impact and grab the audience’s attention while presenting a pres-

entation.

Transitions control how your presentation moves from one slide to the next. Animations control how objects in a 

particular slide move onto, off of, and around your slides. 

A balanced use of animations and slide transitions can lead to an effective presentation.

How to add sound to each slide that has a transition?

Step 1:  Press and hold the Ctrl key while you select the transition slides that you want to add a sound to.

Step 2:  Click Transitions > Sound.  Choose the sound from the drop-down.

Step 3:  Click Transitions > Preview to hear the sound while the transition plays.

LAB ACTIvITY

Create a presentation about pet animals with five  slides. Type two sentences about the pet animals in each slide 

and use numbering format.  

Save it as “My Pet animals. pptx”.

1.  Open “My pet animals.pptx” presentation.

2.  Open Animations tab and use custom animation.  Use any animation of your choice for the cat slide
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3.  Use the entrance animation for the dog slide.

4.  Add grow/shrink to the picture in slide No.3.

5.  Apply ‘boomerang’ to one of the slide as above.

6. Try this animation to the rabbit picture.

7. Apply exit animation for the fourth slide.

8.  Close and save the presentation.

TRY THESE ExERCISES  IN THE LAB
1. Create a presentation about computer with the heading “Modern calculating machine-computer”.
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2.  Apply the any design and transition in the animations tab and save the presentation as “Computer.pptx”.

3.   Insert the image of Charles Babbage and type “Father of the Computer” as title.  Change the transition to 
“wheel clockwise” and change the transition speed to slow.  Now change the transition of the slide to Wheel 
counterclockwise and speed to “fast” and see what happens.

4.    Bullet format and change the transition of the letters to Boomerang.

5.   In the fourth slide include a picture of a CPU and make the transition to this slide “uncover Right down”.  
Change the transition speed to medium and note down the difference.

6.    Add a transition sound to “applause” on Mouse click.

7.   Add two more slides to the presentation with the layout “picture with caption.”

8. Copy and paste pictures of various types of computers.  Give the transition to the added slides “wipe up and 
wedge” respectively, automatically after 3 seconds with a transition sound of Chime. Save the presentation 
with the name “Computer.pptx” 
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9. Create a presentation about “Our National Flag”. Insert a picture of our national flag in slide 2 and write 2 
sentences about our flag.

10. In the consecutive slides type in the information about the ratio of the width and length of the Indian national 
flag, designer of the flag, the values symbolized by the three colours of the flag, etc.

11. Present a slide show and animate the pictures in the slides as per your choice and save the presentation.
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 BRAIN dEvELoPER 

I) FILL IN THE BLANKS

1.  ___________ and animation effects provide ____________ and grab the audience’s  attention while  

 presenting a presentation.

2.  _________ controls how your presentation moves from one slide to the next. 

3.   _________ controls how objects in a particular slide move onto, off of, and around your slides.

4.    An __________ animation does something to draw the attention of the audience towards the object.  

5.  ______________ and ________________ effects provide visual impact and grab the audience’s attention  

 while presenting a presentation.

6.   A balanced use of ___________________________ can lead to an effective presentation.

Teacher’s Signature

Only the most important 

snippets of information  

in the presentation  

must be animated.
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HTML-An Introduction
Ch

ap
te

r

1
In today’s world, the largest open network is the Internet, a worldwide computer network that provides access to 

different websites on World Wide Web (www). 

You can download any information or documents containing text, sound, graphics or video from the Internet 

with the help of a web browser. In fact, web browser is software that enables a computer to display the documents 

located on computer’s network. The documents on network are called hypertext (if the media is text only) and 

hypermedia (if it includes text as well as graphics).

Have you ever thought how these documents are displayed on the Internet? If your answer is no, then let us learn 

the procedure to view the information on computer screen.

The information appears page by page on the screen and these pages are referred as web pages. These contain text 

as well as graphics. These web documents are written in a special language called HTML.(Hyper Text Markup 

Language).

Hyper Text Markup Language (HTML) is a language to design and display web pages on the Internet with the 

help of web browsers. It includes texts as well as graphics. It also provides the means to link the pages on the In-

ternet.

BASIC STRuCTuRE oF AN HTML doCuMENT

An HTML basically comprises of text. The contents of the document are written using tags which are enclosed in 

angle brackets. These tags are understood by the web browser to display the contents of the document on the web 

page. However, tags don’t appear on the web page.

The general format of an HTML document is given below:

 

 
 
 
 
<HTML> 
 
 
 
 
 
 
</HTML> 

<HEAD> 

<TITLE> ……………………………………………………… 

</TITLE> 

</HEAD> 

 

<BODY> ……………………………………………………… 

…………………………………………………………………. 

The body of the document to be written in this part. 

</BODY> 

HTML Tags
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Every HTML document includes some tags which are enclosed in angle brackets, ie.,< >. 

Anything which is not in angle brackets is taken as simple text by the web browser and is displayed on the web page. 

HTML tags basically are of two types:

•	 Container	tags

•	 Empty	tags

Container tags:

These tags in an HTML document 

are in pairs (ie., Start and end tags) 

along with angle brackets (<>). 

They are also known as ON tag 

and OFF tag respectively. ON tag 

uses angle brackets whereas OFF 

tag is used with forward slash (/ ) 

after the opening of angle bracket  

( < ) .

<HTML>

…………………………………
…………………………………
…………………………………
…………………………………
…………………………………
…………………………………
………………

…………………………………
…………………………………
…………………………………
…………………………………
…………………………………
…………………………………
……</HTML

Empty tags: 

Empty tags do not require 

a closing tag in an HTML 

document. It means, an empty tag 

has ON tag only in the document 

which is understood by the web  

browser.…………………Eg., 

<BR> tag is used to leave a blank 

line between the two paragraphs. 

<HTML>
…………………………………
…………………………………
…………………………………
……..
CLASS :V <BR>
D.A.V. GROUP OF SCHOOLS 
<BR>
</HTML>

On August 6, 1991, the first 
website http://info.cern.ch 
went online.

Did you Know
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HEAd Tag and BodY Tag:

Every HTML document consists of <HEAD> and the <BODY>

<HTML> document

<HEAd> <BodY>

<HEAd>: 

The heading of the document is 

generally written in this portion. 

However, <HEAd> tag includes 

another tag, called <TITLE> tag.

<HTML>

<HEAD>

<TITLE>CLASS V </TITLE>

</HEAD>

</HTML>

<BodY>:

The <BodY> tag is the actual 
text of an HTML document 
which appears on the web page. 
The <BodY> tag starts just 
below </HEAd> tag which 
indicates the beginning of the 
HTML text. The </BodY> 
indicates the end of text.

<HTML>
<HEAD>
<TITLE>CLASS V</TITLE>
</HEAD>
<BODY>
AN INTRODUCTION TO 
HTML
</BODY>
</HTML>

CREATIoN oF A wEBPAgE

STEP 1: Open a text editor.

Start  All programs  Accessories  Notepad

STEP 2: In the appearing Notepad, type the HTML document.
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STEP 3: Save the file as .html or .htm

Click File  Save (or) Press Ctrl + S

In the “File name” text box, type a file name with .htm or .html extension.

For Example, type “First.htm”

Click the “Save” Button.

To vIEw THE wEBPAgE IN THE BRowSER:

STEP 1: Open a browser (Internet Explorer or Google Chrome or any browser)

STEP 2: File  Open (Internet Explorer) or press Ctrl+O (In Google Chrome)

STEP 3: From the “Open” Dialog box, browse the folder in which the

HTML document is saved. Choose the file name and click “Open” button. 

Now, your webpage is displayed in the browser as given below:

output: 1.0
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LAB ACTIvITIES:

1. Create different webpages to perform the following:

a. To print your school name on the screen.

b. To print the number from 1 to 10 on the screen.

c. To set the title of the page to “MY FIRST WEBPAGE” and  display the body message as“WELCOME 

TO HTML WEB DESIGNING”.

d. To display your friend’s name on the screen; do not include a head section in the code.

e. Repeat (d) by including a head section in the code.

2. Rearrange the below format of HTML code to be understood by the browser

</HEAD>

<HTML>

</TITLE>

SAY NO TO POLYBAGS

<TITLE>

</BODY>

Government has banned the use and manufacturing of recycled polybags. This will definitely 

help in reducing pollution and other health hazards.

<BODY>

<HEAD>

</HTML>

Jean Armour Polly coined the 

term “Surfing the Int
ernet”.
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Teacher’s Signature

 BRAIN dEvELoPER 

I) FILL IN THE BLANKS:

1. HTML means ………………………………………………………… .

2. The text documents on internet are called ……………………… .

3. Every HTML document begins with …………… and ends with ………… tags.

4. An HTML document is saved with an extension ……………….. .

5. The tags which comprise start and end tags, are called ………………… .

II) MuLTIPLE CHoICE QuESTIoNS:

1. HTML stands for

 (a) Hyper Text Makeup Language  (b) Hyper Text Markup Language

 (c) Hyper Text Machine Language  (d) Heavy Text Making Language

2. HTML documents include

 (a) Text  (b) Graphics  (c) Sound  (d) animation effects  

    (e) all of the given

3. A coded HTML command that indicates how part of a web page is displayed is called 

 (a) Attribute (b) Tag  (c) Style  (d) all of the given

4. HTML file can be edited with

 (a) Windows notepad  (b) MS-Word  (c) Word Perfect  (d) all of the given
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PARAgRAPH TAg

Browser applications are having some special rules for displaying text. They do not recognize returns, tabs or even 

more than one space between words. 

If you create an HTML document with more paragraphs, the browser will display the entire document as a single 

paragraph.

However, it is necessary for the paragraphs to appear in the same fashion as they are indicated in the original 

HTML document.

To perform the above task, HTML provides the<P> tag at the beginning of each paragraph and </P> at the end of 

each paragraph which are referred as Paragraph Tags.

Let us consider an example to enter your details using paragraph tag as illustrated:

Example 2.0

The above document, when viewed as a webpage is shown below:

PARAgRAPH TAg ANd  
LINE BREAK TAg Ch

ap
te

r

2
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LINE BREAK TAg

You might have realized that the presentation of the above HTML document on the web page is not to your satis-

faction. The carriage has returned more than one time between the lines. 

To rectify this problem, <BR> tag is used. The <BR> tag is an empty tag and thus it does not require closing tag. 

This tag is written at the end of the line. 

Let us re-write the previous HTML document using <BR> tag.

Now, you can view the above document on a web page, which is as per your requirement.

output: 2.1

The <hr> element is most often displayed as a 
horizontal rule that is used to separate content 

(or define a change) in an HTML page.
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LAB ACTIvITIES

1. Write an HTML coding to display a webpage as given below using the line break and paragraph break wherever 

applicable:

Make a list,

From one to twenty,

You can have more,

If you want to have plenty.

Your bucket list,

Will hold your dreams.

That one day,

Won’t be a dream.

Setting goals,

Is good to do,

To make your dreams

Come true for you.

2. Createa a webpage which includes the following information of your school, using paragraph tags for the spaces 

in between the lines.

NAME OF THE SCHOOL :

NAME OF THE PRINCIPAL :

LOCATION :

CITY :

PINCODE :

3. Using the line break tag, format the following into four different lines with two lines spacing in between the 

lines.

OM BHUR BHUVAH SWAH; TAT SAVITUR VARENYAM; BHARGO DEVASYA DHEEMAHI; DHIYO 

YO NAH PRACHODAYAT.
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 BRAIN dEvELoPER 

I) TRuE oR FALSE :

1.  The <BR> tag resets the paragraph alignment to the default left alignment ………….. .

2. The <P> tag is used to break text into paragraphs ……………. .

3. <BR> is a container tag ……………… .

4. When HTML page is displayed by a web browser, it does not take care of carriage returns ………………. .

5. Line break tag is an empty tag …………… .

II) PREdICT THE ouTPuT FoR THE gIvEN HTML CodE:

<HTML>

<BODY>

<P> PREDICT THE OUTPUT </P> 

THIS IS<BR>AN EXAMPLE TO EXPLAIN<BR>PARAGRAPH TAG<BR> WITH LINE BREAKS

</BODY>

</HTML>

Teacher’s Signature

SGML stands for Standard  
Generalized Markup Language.

DiD You Know
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FoRMATTINg  
FEATuRESCh

ap
te

r

3
The <FONT> tag lets you change the face, size and colour of the text. It is generally used for changing the appear-

ance of a short segment of text. Let us learn how we can use <FONT> tag for these purposes.

Changing the Font Face: FACE Attribute

The face attribute changes the font face of the text that is displayed. Eg., <FONT face=Arial> Happy </FONT>

Changing the Font Size: SIZE Attribute

The size attribute is used to change the size of the text. The value of the size attribute of <FONT> tag must be one 

of the virtual font sizes(1-7). The default size is 3.Eg., <FONT size=5> M </FONT>y First Page

Changing the Font Colour: COLOR Attribute

The color attribute changes the colour of the text that will appear on the screen. Values can be given either as RGB 

components (##RRGGBB) number or with colour names. Eg., Red, Blue, Green etc. This colour appears only to 

the text surrounded by the <FONT> tags.

Eg.,<FONT color=red> This appears in red colour </FONT>

The following example, illustrates the use of face, size and color attributes of the <FONT> tag.

Example 3.0
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The output of the above program is as follows:

output: 3.0

There are also container tags in HTML as shown below:

oPENINg TAg CLoSINg TAg dESCRIPTIoN

<B> </B> The text will be bold

<I> </I> The text will be italicized

<U> </U> The text will be underlined

<STRIKE> </STRIKE> The text will have a line over it

<SUP> </SUP> The text will be superscripted

<SUB> </SUB> The text will be 
subscripted

Bold Face :

The container tag <B></B> lets the text enclosed in it appear as bold face. 

Eg., <B>  Bold Text </B>

Italics:

For italicized text, you can use <I>and</I> tags to enclose the text. For the text to be bold and italics use both the 

tags as given below:

Eg.,<B><I> This is both bold and italics </I></B>

underlined text:

The container tag<U></U> lets the text enclosed in it underlined.

Eg.,<U> This is an underlined text </U>
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Strikethrough:

The container tag <STRIKE></STRIKE>is used to draw a strikethrough on a section of a text.

Eg.,<STRIKE>Enemity</STRIKE>

Subscript:

This container tag <SUB></SUB> makes the enclosed text appear as subscript. For eg.,to display the chemical 

formula H2O, you can write it as follows:

Eg., H <SUB> 2 </SUB> O

Superscript:

This container tag <SUP></SUP> lets the text enclosed in it appear as superscript as compared to the rest of the 

text.

Eg., To display X2, it is written as follows:

X <SUP> 2 </SUP>

The following coding illustrates the few of the container tags in formatting. 

Example 3.1

HTML supports 140 standard 
colour names like Tomato,  

Orange, SlateBlue, DodgerBlue, 
Gray, Violet, MediumSeaGreen, 

LightGray etc.,
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The output for the above coding is as follows:

output: 3.1

LAB ACTIvITIES:

1. Create different web pages to perform the following:

 a. To display a paragraph to describe any two of your hobbies.  

  i) Underline the hobby names; ii) Italicize and Boldface the description of your hobbies.

 b. To display in the following format:

12=1

22=4

32=9

42=16

52=25

c. To display any three names and each name should have a number as a subscript to make the list alphabetized.

 For example,

Steve Jobs
2

Bill Gates
1
       

Sundar Pichai
3
   

2. Create a webpage to display the following super heroes, each with the specified font style, size and colour.

THOR -  COMIC SANS MS, 7, RED

CAPTAIN AMERICA -  ARIAL, 5, BLUE

HULK  -  ALGERIAN, 7, GREEN



55

3. Repeat the given line 5 times, each time in a different font style, size and colour.

IT ALWAYS SEEMS IMPOSSIBLE UNTIL IT IS DONE.

 BRAIN dEvELoPER 

I) FILL IN THE BLANKS 
1. The format for colour specification in HTML is-------------------

 a. * rgbrgb b. #rrggbb c./rrggbb  d. rrggbb

2. The ----------- tag displays an underline effect for the text.

 a. <I>  b. <U>    c. <B>   d.<SUB>

3. In an HTML document, size of the font may vary from ------------

 a. 1 to 5 b. 1 to 7 c.1 to 3 d. None of the above

4. ---------tag is used to make the text appear boldfaced than the rest of the text

 a. <I>           b. <U>  c. <B>

5. ------------ attribute is used to change the size of the text

 a. COLOR       b. SIZE      c. FACE

II) TRuE oR FALSE 

1. The FONT tag has three major attributes: SIZE, COLOR AND FACE ................. .

2. The colour can be changed either by using one of the hexadecimal values or colour names. ................... .

3. The default size of the font is 5 ................... .

4. The <STRIKETHROUGH> tag is used to strike over the text ……… .

5. The <SUP> tag displays certain portion of the text, a little above the normal line level  ……… .

Teacher’s Signature

<STRONG>  
tag defines strong  
text, with semantic  

“strong”  
importance.

Did
You
Know?
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Headings break up large areas of text; announce topics to follow and information of all ranges according to a log-

ical hierarchy. HTML provides six levels of headings. <H1> is the highest level and the largest of all headings and 

<H6> is the lowest and the smallest level of heading. The heading styles result in automatic line break.  The various 

heading tags are:

<H1> … </H1>

<H2> … </H2>

<H3>… </H3>

<H4> … </H4>

<H5> … </H5>

<H6> … </H6>

The following code illustrates the use of heading element:

Example 4.0

HEAdINg STYLES
Ch

ap
te

r

4
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The output of the above code is shown as follows:

output: 4.0

By default, all browsers align headings on the left. Most browsers however support alignment attributes, which also 

allow you to right align with centre headings.

The following table shows the alignment attributes:

HEAdINg ATTRIBuTES EFFECT

ALIgN=LEFT Aligns the heading to the left 

ALIgN=RIgHT Aligns the heading to the right

ALIgN=CENTER Aligns the heading in the centre

ALIgN=JuSTIFY Aligns the heading between the two margins

<H1 ALIGN=LEFT> Left-Aligned Heading </H1>

<H1 ALIGN=CENTER> Centered Heading </H1>

<H1 ALIGN=RIGHT> Right-aligned Heading </H1>

<H1 ALIGN=JUSTIFY> Justified Heading </H1>

 To use the alignment attributes, include them in the initial heading tag, like this. 
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LAB ACTIvITIES

1. Create different web pages to perform the following:

 a. Introduce an<H1> level heading and name it as“MY FAVOURITE SPORT”, and type three lines of  

  description on that heading, each line with different heading size and alignment.

 b. To print your favourite cricketer’s name on the screen with every letter being a different heading style on  

  different lines.

 c. To type your family members name, each in a different heading style. 

 d. Perform the following to display:

  i. Our country using <H1> tag.

  ii. Any five states in the decreasing order of heading levels.

 BRAIN dEvELoPER 

I) FILL IN THE BLANKS

1. HTML provides the heading ranging from ……… to ………. .

2. …….. is the highest level of heading.

3. ……… is the lowest level of heading.

4. The most important headings in HTML document are given using the tag   ………... .

5. The alignment options in heading styles are ……………… , …………… ,………………..  

 and ……………..

II) wRITE HTML CodE To dISPLAY THE FoLLowINg ouTPuT

Heading 1
Heading 2
Heading 3
Heading 4

Heading 5

Heading 6
Teacher’s Signature
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Making information more accessible is the single most important quality of HTML. Beyond embellishing your 

text with specialized text tags, HTML also provides a rich set of tools that help you organize content into formatted 

lists. 

HTML lists are basically of three types:

i) Unordered List 

ii) Ordered List

iii)  Description List

uNoRdEREd LIST

Each item of unordered list has a special bullet symbol in front of it. The whole list is enclosed in <UL> and </UL> 

tags. Each item of the list should be enclosed in <LI> and </LI> tags.

unordered Lists – Bullet Styles

The following code illustrates the use of heading element:

Type value Numbering style

Disc •	A	solid	circle		

Square  A solid square

Circle o An unfilled circle

THE TYPE ATTRIBuTE

The “TYPE” attribute is used to customize the bullet style for the list of elements. This attribute may have a value 

of disc, circle or square. The default bullet is a disc ie.. solid circle. 

LISTS-oRdEREd LISTS 
ANd uNoRdEREd LISTSCh

ap
te

r

5

Description list is 
used to list the items 
with a description for 

each item.
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The following code describes the various bullet types.

Example 5.0

The output of the above program is as follows:

output: 5.0
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oRdEREd LISTS

The numbered list is created within the <OL> …. </OL>. The tag <LI> is used to present the item list. The 

ordered list displays the items in a numerical or alphabetical order. Both <OL> and <LI> tags are container 

tags. The “TYPE” attribute is used to change the number style. The default numbering style is the Standard 

ArabicNumerals1,2,3,4….

The “START” attribute is used to specify the start value of the first list item in the ordered list. The default starting 

point is one. 

Ordered list- numbering styles

Type value Numbering style

1 Standard Arabic Numerals 1,2,3,4,……………….

a Lowercase letters a, b, c, d, …………

A Uppercase letters A, B, C, D ………..

The following coding illustrates the numeral list.

 

Example 5.1

The output of the above coding is as follows: 
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output: 5.1

The following code displays the names of cricket players in Uppercase roman numerals.

Example 5.2

The output of the above coding is as follows:

output: 5.2
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The following code illustrates the usage of the type and start attribute

Example 5.3

The output of the above program is as follows:

Output: 5.3
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LAB ACTIvITIES

1.  Create different web pages to perform the following:

 a. To display any five national leaders using numbering format. Change the format of the ordered list  

  for each national leader.

 b. To display the following:

  I. METALS

   a. Gold

   b. Silver

   c. Iron

   d. Copper

  II      NON-METALS

   i. Oxygen

   ii. Sulphur

   iii. Nitrogen

2. Create a webpage to apply different shapes of bullets for the below:

 HEALTH HAZARDS OF JUNK FOODS

	 	 	 •	 Obesity

    Headache

   o Addiction

3. Create a coding using unordered list to display the following output:

  Five Moral Values for Children: 

	 	 	 •	 Respect	everyone

	 	 	 •	 Be	honest

	 	 	 •	 Never	hurt	anyone

	 	 	 •	 Develop	helping	mentality

	 	 	 •	 Cultivate	good	behaviours

HTML supports  
nested list or a sub 
list i.e., a list within  

a list.
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 BRAIN dEvELoPER 

I) FILL IN THE BLANKS

1. HTML lists are basically of ……………. and ………………types.

2. <LI> tag in an …………… list will display sequence numbers.

3. <LI> tag in an ……………….. list will display bullets.

4. …………. is the default shape of bullet in unordered lists.

5. The ……….. attribute is used to change the numbering style or the bullet style.

II) TRuE oR FALSE

1. By default, the numbering in an ordered list starts with 1.

2. The shapes of bullets are disc, square and ellipse.

3. The <LI> represents the list of items in the ordered and unordered lists.

4. The unordered list has numbers or alphabets in front of each element instead of bullets.

5. The START attribute can be started from any number even other than one.

Teacher’s Signature



66

CREATIvE zoNE
Mehul is fond of creating more colourful webpages. With the help of the following background colours and codes, 

join with Mehul to see more colourfulwebpages.

Given below are the colour codes. Enjoy creating colourful webpages.

Colour Name Hexadecimal value Colour Name Hexadecimal value

Red #FF0000 Olive #808000

Blue #0000FF White #FFFFFF

Green #008000 Black #000000

Yellow #FFFF00 Maroon #800000

Lime #00FF00 Grey #808080

Purple #800080 Aqua #00FFFF

Silver #C0C0C0 Brown #A52A2A

Hmm...How to 
make my webpage 
colourful??!!!  

 It’s very easy, just type,
<BODY B 

GCOLOR=”FF0000”>   
OR

<BODY BGCOLOR= 
”RED”>

Teacher’s Signature
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IT SCHOOL@

IT SCHOOL@
User Skill  

Typing Tutor
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TYPINg TuToR  
INTRoduCTIoN

 The knowledge of touch typing has become inevitable today in the use of computers.

 With typing tutor, you can learn touch typing in an easier and simple way.

 It is very similar to you that there are 26 letters in English alphabet. All these 26 letters are presented in the 
computer keyboard too.

 But, 26 letters are not arranged in an alphabetical order.

	 The	letters	in	the	keyboard	is	arranged	in	QWERTY	order.

TYPINg STEPS

Follow the steps below:-

Step 1: First of all place your hand on the keyboard.

Step 2: Place your

 Little finger of your left hand gently on the ‘A’

 Ring finger on ‘ S ’

 Middle finger on ‘ D ’

 Index finger for both ‘ F ’ and ‘ G ’

Step 3: Place your

 Little finger of your right hand gently  
on the key semicolon ‘ ; ’

 Ring finger on ‘ L ’

 Middle finger on ‘ K ‘

 Index finger for both ‘ H ’ and ‘ J ’
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Step 4: Place both your left and right thumbs on the spacebar key.

Lets start typing. Whatever it may be letter or numbers all most all the keys you can see around your fingers.

LEFT HANd FINgER
Name of the Finger Keys on the Keyboard

Little Finger A

Ring Finger S

Middle Finger D

Index Finger F,G

Thumb Spacebar

RIgHT HANd FINgER
Name of the Finger Keys on the Keyboard

Little Finger ;
Ring Finger L
Middle Finger K
Index Finger J,H
Thumb Spacebar

THE QwERTY LAYouT

The	keys	on	the	keyboard	is	arranged	in	QWERTY	layout.	The	layout	is	referred	to	us	as	“QWERTY”	because	of	

the	arrangement	of	the	keys	in	the	upper	row	is	QWERTY.



71

HoME Row

The finger of an experienced typist never “rest” However, if we could ask the fingers where they spend most of their 

time, it is over the home row.

When you are still learning to access keyboard, be careful to keep at least one finger of each hand anchored over 

the home row.  

uPPER Row / QwERTY Row

QWERTY	Row	is	located	just	above	the	Home	row.	It	contains	many	number	of	characters.

LowER Row

Lower Row is located just below the home row, contains limited number of keys.

NuMBERS Row

Numbers Row is located above the upper row, number keys are also available in a separate place at the right side 

of the keyboard.

ANCHoRINg

Anchoring means to keep a finger in very light contact with its home row key.

During the early stages of learning keyboard, this is necessary for the brain to develop a sense of position for the 

hands and fingers.

As you become a more skilled typist, your fingers will automatically move to the correct position of the keys.
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